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Signature:     
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WEEE Regulations 2006 

 
Cambridge Sensotec takes its responsibilities under the WEEE 
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1. Introduction 
 
The Rapidox 1100Z oxygen analyser allows fast and accurate oxygen analysis over 
the  oxygen range 1ppm to 100% O2.  The analyser provides continuous on-line 
oxygen analysis, with a typical response time of less than 4 seconds for a 90% 
response to a step change in gas compositions. 
 
The Rapidox 1100Z is a fully integral unit complete with a powerful diaphragm 
pump to provide gas sampling at approximately 1 litre per minute.  
 
The sensor head is located inside the analyser and comprises a zirconia ceramic 
tube that needs to be heated to 650°C before it will conduct oxygen ions.  The 
analyser supplies heat to the sensor, which is controlled very accurately by a 
regulated power supply incorporated in the instrument.  An internally mounted 
pressure sensor compensates for any fluctuations in pressure or vacuum caused 
by differing flow conditions. 
 
The analyser is packed with features including programmable alarm circuits, 
programmable analogue outputs, easy calibration (user selectable gases), RS232 
communications and complete communications / data-logging software. 
 

2. Features 
 

 Very fast measurement response (typically 1-4 seconds for a 90% response). 
 

 Wide measurement range available (1ppm to 100% O2). 
 

 High accuracy maintained throughout the measurement range.  Accuracy ± 
1% of the actual measured oxygen with a precision of ± 0.5%. 
 

 Easy calibration procedure requiring any two gas mixtures (ordinary room air 
is usually one). 
 

 Low maintenance, sensor life expectancy typically 35,000 hours 
 

 Powerful diaphragm pump fitted for sampling the gas 
 

 Large back-lit LCD display (16 x 2 characters). 
 

 RS232, 0-10V and 4-20mA current loop outputs (both programmable). 
 

 Fully programmable alarm circuits (high and low conditions). 
 

 Full data-logging software accessed via RS232 connection to a PC (RS485 
available on request). 
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3. Specification 
 

3.1 Rapidox 1100Z Dimensions 
 
Case dimensions: W=250mm; D=263mm; H=150mm.  Weight=5kg.  Power 
supply is factory set on ordering: 47-63 Hz Power 100VAC, 120VAC 220VAC, 
240VAC.  Metal carrying handle supplied. 

3.2 Accuracy and Precision 
  
Sensor response time is typically 1 second for a 90% response involving a step 
change in composition.  A change between 21% and 100% can be recorded in less 
than 4 seconds depending on flow rates.  High accuracy is maintained between 
calibration points.  Accuracy is ±1% of the actual measured oxygen content with a 
precision better than ±0.5%.  Outside the calibration range accuracy is typically 
±2.5%. 

3.3 Display 
 
The analyser has a 2-line 16x2, 9mm character, back-lit liquid crystal display 
(LCD) , whose data update rate is user-programmable.  The LCD displays four 
significant figures of oxygen (O2).  The display notation (percent, ppm, 
exponential or ‘automatic’) is user selectable.     

3.4 Calibration 
 
The simple and fully flexible calibration procedure requires two calibration gases 
(ambient air 20.95% is normally used as calibration gas no. 1).  The calibration gas 
compositions are user-selectable and programmed into the Rapidox via the keypad 
menu or the RS232 link and configuration software.  Factory pre-sets can be 
reloaded to allow the unit to be 'rescued' from a failed calibration.  The Rapidox is 
calibrated using the keypad on the front panel or directly with the software 
provided.  The LCD changes to calibrate mode to inform the user of progress. 

3.5 Operating Temperature 
 
Gas inlet temperature must not exceed 60oC.  The Rapidox unit’s normal operating 
temperature is 5-35oC. 

3.6 Outputs 
 
The RS232 serial port (RS485 is available on request) outputs on demand values 
for oxygen (ppm), pressure (mbar), time (hh:mm:ss) and date (dd/mm/yy).  This 
data can be downloaded and logged using the software provided. 
 
Standard 0-10V and 4-20mA analogue outputs are available on the rear panel for both O2 
and pressure, as are 10V (logic level) O2 alarm signals (High and Low conditions).  These 
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outputs are fully user-programmable via the front keypad or RS232 link and the supplied 
configuration software. 
 

4. Technical Specification 
 
 

Property Specification 

Supply Voltage 
110-115 or 220-240Vac (factory set) 50/60 
Hz 

Power consumption 100W (max) 
Analyser dimensions 250mm X 263mm X 150mm 
Weight 3 kg 
Display 16 × 2 character (9mm) back lit LCD 
Warm up time 3-4 minutes at 20°C 
Normal operating temperature 5-35°C 

Outputs: O2 & pressure 
0-10V (user-programmable) into minimum 
5kΩ 

  O2 & pressure 
4-20mA current loop (user-programmable) 
into maximum 500Ω 

  O2 high and low alarms Relay circuits 

  All data and parameters 
RS232 or RS485 - data streamed on 
demand 

Sample Pump Mains type diaphragm vacuum pump 
Maximum Free Air Displacement 1.3 L.min-1  
Max. gas temperature on input 60°C 

Calibration 
Requires 2 user-selectable gas 
compositions (air is default plus another) 

5. Precautions 
 
Make sure you read and understand these instructions and keep them safe for later 
use.  The unit should not be exposed to extreme temperatures < -5°C or > 60°C.  
Normal operating temperature is 5-35°C.  Avoid direct sunlight.  Do not use liquid 
cleaners, aerosols or solvents to clean the case.  Use a damp cloth for cleaning.  Do 
not use this equipment near water.  Avoid touching the LCD display as this may 
cause permanent damage.  Make sure the rear ventilation slots and the fan on the 
rear panel are free of obstruction. 
 
There are no user serviceable parts in this unit.  Do not attempt to repair yourself.  
Refer all servicing to qualified Cambridge Sensotec personnel. 
 

6. Warning 
 
This unit is NOT designed for use in life support situations.  No responsibility can 
be held for injury or loss of life caused by inappropriate use of this equipment. 
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7. Rapidox Operating Instructions 
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Figure 1: Rapidox 1100Z front panel.  Numbers are referred to in the text. 
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Figure 2: Rapidox 1100 rear panel.  Numbers are referred to in the text. 

7.1 The Rapidox Analyser - Menu System 
 
All of the user-programmable functions are accessed via a menu system which is 
controlled using the front panel Keypad (2).  To access the menu press the ENT 
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button and to escape and return to the operating screen press ESC at any time.  
The menu system flow chart is shown below: 
 

7.2 Getting Started 
 
Ensure that the Rapidox analyser is located away from extreme heat and dirt 
environments.  Plug the unit in to a suitable supply (noting the information on the 
serial sticker and using the power cable supplied) using the rear power socket (8).  
Make sure that the cooling fan (9) is not obstructed during operation.   
 
Push the gas sample tube (6mm OD/4mm ID) to the GAS IN (3) connector and fit 
the retaining collar hand tight.  Repeat for the GAS OUT (4) connector should an 
outlet tube be required. 
 
Turn the unit on using the red power switch on the front (5).  The LCD (1) will 
display the firmware version followed by the message “HEATING SENSOR”.  The 
sensor will take approximately four minutes to come up to temperature, after 
which the Rapidox will begin to take measurements.  The progress of the sensor 
heater is shown in the form of a bar graph on the LCD (1).  Once at temperature 
the LCD display will show the oxygen reading and the pressure.  The word 
*ALARM* may appear to the bottom right of the LCD if the alarm system is 
enabled and an alarm condition applies. 
 
Allow thirty minutes for the box to stabilise fully.  This allows the components of 
the analyser to reach a stable working temperature.  During this warm-up period it 
is common for the baseline oxygen to drift by a small amount, which may be 
corrected by re-calibrating. 
 

7.3 Rapidox Calibration 
 
Once the unit is at temperature it may be necessary to calibrate the sensor.  Full 
calibration is a simple procedure requiring only two gases (one of which is 
normally air – 20.95%).  The two gas values are user-selectable and can be 
changed by using the front keypad (2) or the communications software described 
in section 8, and the calibration values can be stored on file for later use. 
 
Care must be taken to calibrate the analyser so that, whenever possible, the range 
of measurement lies between the two calibration points.  For example, if you are 
working at 10ppm but have calibrated the analyser between 21% and 100% then 
the analyser will be inaccurate.  You would need to calibrate at, say, 1ppm and 
21% to be sure of good accuracy.   The procedure is as follows: 
 
1) Bearing in mind the points made above decide which two gases you are 

going to use for calibration.  If you are constantly working at a particular 
range of compositions then it would be wise to obtain small cylinders of 
calibration gas with analysis certificates.  You may need to programme the 
analyser and tell it which two gases you are using.  This procedure is 

 
5 

 
 



Cambridge Sensotec Rapidox 1100 Oxygen Analyser Instruction Manual 
 

necessary only when you change calibration gases and is explained in 
section 7.4.  Press the ‘ENT’ button on the front panel keypad (2) to access 
the menu system.  The calibration function is the first item on the menu list 
which can be scrolled using the up and down arrows.  Press ENT again to 
enter the calibration menu.  Use the UP and DOWN arrows to select either 
GAS 1 or GAS 2 and press ENT to proceed.  The top line of the display 
shows the gas selected and the bottom line of the display shows the 
prompts.  If either GAS 1 or Gas 2 are not what you require you need to 
reprogram the cal gases using the procedure described in 7.4. 

 
2) The sensor needs to be exposed to the first calibration gas from a cylinder 

(or exposed to ambient air, 20.95% if this is the calibration gas of choice).  
Allow several minutes to pass to flush the sensor properly.  Wait for the top 
line of the display (1) to become stable.  To complete the calibration press 
and HOLD the ENT button for two seconds1.  During this time you will see 
a bar graph progress across the lower display.  The analyser will then 
recalibrate and display “Gas 1 recalibrated” and then return to normal run 
mode.  The display will now correctly read the value of the first calibration 
gas.   

 
3) To calibrate against the second calibration gas, repeat the procedure from 2 

but this time press ENT followed by the UP or DOWN button to scroll 
through to the second screen.  The second line will display the second 
stored calibration gas value.   Flush the sensor chamber with the second 
calibration gas allowing several minutes for the new gas to flush through.  
Wait for the display to become stable before pressing the ENT button for 
two seconds1.  The analyser will then recalibrate and display “Gas 2 
recalibrated” and then return to normal run mode.  The display will now 
correctly read the value of the first calibration gas. 
 

4) The analyser is now correctly calibrated and will read accurately between 
these two calibration points.  Note that this procedure can be performed 
remotely using the software described in section 8. 
 

5) If at any time, you encounter difficulties and wish to restore the machine to 
its factory set calibration, use the configuration software provided and load 
the default settings (described in section 8.4 below).  Each machine is 
provided with a unique file that contains the factory settings.  This is 
located on the CD-Rom provided and is copied onto your PC during the 
installation process. 

 
NB You must always perform a FULL calibration to achieve good accuracy.  
Only calibrate the Rapidox when in NORMAL mode and with no PRESSURE 

CORRECTION set (see below for details). 
 

                                                 
1 Note that if the ‘ENT’ button is released before two seconds have elapsed, the recalibration will be 
aborted and the analyser will return to run mode using the existing calibration. 
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7.4 Selecting the Calibration Gases 
 
Any two calibration gases can be used to calibrate the Rapidox although it is 
recommended that one is always air (20.95%).  You can reprogram the two 
calibration gases to suite your needs via the menu (2) on the front panel or by 
using the software provided (section 8.5.2).  Press ENT to access the menu and 
scroll down to option 2 “Set Cal. Gases”.  Press ENT to proceed.  Use the UP and 
DOWN arrows to select cal gas 1 or cal gas 2.  Press ENT to edit the value.  On the 
edit screen you can use the RIGHT arrow to move the blinking cursor across to the 
character you wish to change2.  Use the UP & DOWN keys to change the value.  
You can also change the sign of the exponent in the same way.  Note that for ease 
of editing the cal gases are written in ppm Exponent format so air (20.95%) would 
read 2.095E+05ppm.  When you have finished editing the value press ENT to 
store it in memory.  Now repeat the operation for the second cal gas.  These values 
will remain in memory until you re-edit them in the future. 
 

7.5 Cleaning the Sensor 
 
You can clean the sensor at any time by pressing ENT on the keypad (2) and 
scrolling down to option 3 “Clean Sensor” or using the software described in 
section 8.7.  Press the ENT button to proceed.  The screen displays “Clean 
Sensor?”.  Press ENT again and the cleaning will take place.  The procedure takes 
approximately five seconds and the LCD display shows the progress of the 
operation.  Once finished the analyser will take a moment to re-stabilise.  The 
sensor is cleaned each time the unit is switched on prior to operation.  If you are 
operating in gases with large amounts of soot, there is a risk that the sensor 
surfaces will become contaminated with particulates, which will impair 
performance if allowed to build up.  The cleaning operation pumps oxygen 
through the zirconia tube, which burns the particulates away from the sensor 
surface. 

7.6 Alarms 
 
The Rapidox is fitted with fully programmable alarms.  There are two independent 
alarm circuits for low and high oxygen conditions and the connections are made 
on the rear panel (6).  These are relay circuits which are open if there is no alarm 
and closed when an alarm condition occurs3.  You have the option of enabling the 
alarm circuits, enabling an audible buzzer and enabling a visual warning on the 
screen. 
 
The alarm set points can be programmed by the user via the keypad (2) on the 
front panel or using the software provided (section 8.5.2).  To change the alarm set 
point scroll down the menu to no. 5 “Set O2 Alarms” and press ENT.  Now use the 
UP & DOWN arrows to select “Alarm Thresholds” and press ENT.  The next screen 
shows the alarm low setting which can be modified in the same way as described 
                                                 
2 Note that you can not go back to edit a previous value.  Instead keep pressing the RIGHT button 
and the cursor will wrap around back to the beginning.  Alternatively press ESC to start again. 
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in 7.4.  Press ENT when finished and repeat for the high alarm setting.  Press ENT 
to finish and return to normal operation. 
 
To modify the alarm options select menu no. 5 again and use the UP & DOWN 
arrows to select “Alarm Status”.  Here you are given the option to enable or disable 
the outputs on the rear, enable or disable the audible buzzer & enable or disable 
the warning on the front screen.  Use the UP & DOWN arrows to select each 
option and ENT to proceed and finish. 
 
When the alarm is activated the warning buzzer will sound and the front display 
will flash the word ALARM in the lower right hand corner. 
 

7.7 Analogue Outputs 
 
The standard industrial analogue outputs (0-10V and 4-20mA) for both oxygen 
and pressure are accessible via the terminal block (6) on the rear panel4.  In the 
case of oxygen, the outputs are factory set to provide a linear response in the range 
0-25% that will cover most applications.  However because of the large range of 
oxygen covered by the analyser, the lower and upper values are fully user-
programmable using the keypad (2) or the software provided (section 8.5.2).  
 
To modify the oxygen analogue output range scroll down the menu to no.6 “Set 
Outputs” and press ENT.  You can now edit the lower and upper values in exactly 
the same manner as described in 7.4 for setting the cal gas values.  Once 
programmed the new values remain in the memory until they are edited again in 
the future. 
 

7.8 Setting the Display Units 
 
The notation used by the display is fully programmable to suit your needs using 
the keypad (2) or the software provided.  The following options are available to 
you: 
 
Oxygen:  The oxygen reading can be displayed in percent (e.g. 20.95%), ppm (e.g. 
0.01ppm) or scientific (e.g. 2.095E+05ppm).  There is also an option to display the 
oxygen reading in terms of a pressure in mbar.  If percent is selected the Rapidox 
will display oxygen as a percentage down to 1% and ppm below this value.   
 
Pressure: The internal pressure sensor reading can be displayed as mbar, bar, torr 
or kPa. 
 

                                                                                                                                                       
3 Note that the alarm circuit relays are accessed via the terminal block on the rear panel and are 
clearly labelled.  The relay circuit is rated at 24V 0.5amps maximum. 
 
4 Note that the ranges of the 0-10V and 4-20mA are tied together so changing one alters the other. 
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To program these options scroll down to menu no. 7 “Set Units” and press ENT.  
Use the ENT key to progress through the list and the UP & DOWN keys to select 
the required units.  Once selected press ENT to store and return to run mode. 

7.9 Setting the Display Options 
 
The user can select the LCD refresh rate and the format of the line 2 display using 
the keypad or the software provided.  Scroll down the menu to option no. 8 “Set 
up Display” and press ENT.  Use the UP & DOWN arrows to select either the LCD 
refresh rate or Line 2 Options: 
 
LCD Refresh Interval:  The frequency of the display update can be selected from 
0.1 to 1.3 seconds.  The current setting can be edited using the same method as 
described in 7.4 for modifying the calibration gas values.  Once edited press ENT 
to store and return to run mode. 
 
Line 2 Options:  The information displayed on line 2 of the LCD can be chosen by 
the user.  The options are Pressure (displayed in mbar, bar, torr or KPa.  Use the 
UP & DOWN arrows to select the display required and press ENT to store and 
return to normal operating mode. 

7.10 Internal Pressure Sensor 
 
The Rapidox 1100Z is fitted with an internal pressure sensor which monitors 
small changes in pressure and vacuum inside the sensor head.  The pressure will 
normally be zero mbar under normal operation but if the unit is being fed by a gas 
cylinder or connected to an apparatus under partial vacuum then the pressure will 
change and this will have a direct effect on the oxygen partial pressure and the 
sensor reading.  You have the option of displaying the pressure reading on the 
LCD display (1).  Select no. 8 “Set Up Display” and press ENT.  Select “Line 2 
Options” using the UP & DOWN arrows and press ENT.  You can set the display to 
read Pressure or None.  Select Pressure and press ENT.  The display will now 
show the pressure reading from the internal sensor.  If you want to view different 
units select no. 7 “Set Units” from the menu and press ENT three times to reach 
the pressure screen.  Us the UP & DOWN arrows to select mbar, bar, torr or kPa 
and press ENT.  The display will now show the pressure in the selected units. 
 

7.11 Pressure Mode 
 
The user has the option of using the reading from the internal pressure sensor to  
automatically correct for changes in gas pressure and hence oxygen pressure.  A 
manual pressure correction value can also be used.  To access this function scroll  
down to menu option 10. “Pressure Mode” and press ENT.  The desired mode can 
then be selected using the UP & DOWN arrows and pressing ENT to store and 
proceed.  The three modes available are: 
 
Auto: This is the factory setting.  If the Auto mode is selected then the Rapidox 
takes then reading from the pressure sensor and corrects the oxygen partial 
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pressure to maintain a concentration reading.  This allows users who are working 
with fluctuating pressures to maintain a ‘meaningful’ reading of oxygen 
concentration that will only be affected by changes in gas composition and not gas 
pressure. 
 
Normal: If this mode is selected then there is no pressure correction performed on 
the oxygen reading.  The pressure and oxygen sensor act independently.  If the 
sensor is working in air (20.95%) and the pressure is doubled to 2 bar then the 
reading will also double to 41.9%.  This is the correct oxygen partial pressure in 
air at 2 bar since there is a simple linear relationship between pressure and 
concentration. 

7.12 Setting the Baud Rate 
 
If you are using the software for data logging you can chose the communications 
speed (Baud Rate) by scrolling down the menu to no. 11 “Baud Rate” and using 
the UP & DOWN arrows to select either 9600 or 57,000.  Press ENT button again to 
store and return to normal operation.  The default factory setting is 57000.  
However if you are using an older PC you can decrease this to 9,600 to improve 
the reliability of the software and data communications. 

7.13 Load Defaults 
 
If you make a mistake programming the Rapidox it is possible to restore the 
machine back to its factory settings by loading the unique default configuration 
that is supplied on your software CD-rom.  The default set-up can only be 
accessed using the software provided.  Please see section 8.4 for further details. 

7.14 RS232 / RS485 Port 
 
It is possible to factory set the data communications port to either RS232 or 
RS485.  Once configured at the factory it is not possible to change unless the unit 
is returned to Cambridge Sensotec Ltd. 
 
Data from the Rapidox is sent on demand to the 9-way 'D' type socket (7) on the 
rear panel and can be read using a simple terminal programme such as 
'HyperTerminal' in Windows, or with the user's own custom software.  
Alternatively a simple and convenient data-logger programme is included with the 
supplied software and is described in section 9 below. 

7.14.1 RS232 Protocol 
 
Oxygen data can be read from the RS232 port at the back of the Rapidox 1100Z.  
The default RS232 configuration is 57600-8-N-1, as shown in this example for 
COM1: 
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Figure 3: Rapidox default COM properties box 

 
Alternatively, the baud rate can be reduced to 9600 via the “Baud Rate:” menu 
item, using the front panel keypad on the Rapidox.  This setting is stored in 
EEPROM. 
 
Connection:  Connect to RS232 socket at the back of the Rapidox using a 9 way D-
type plug.  Signals are as follows: 
 
Rapidox D-type Socket:  PC/PLC: 
Pin# 2 = Data Out   Data In (RX) 
Pin# 3 = Data In   Data Out (TX) 
Pin# 5 = Common/Gnd -- Common/Gnd 
 

 
 
 
 
 

RS232 

5 4 3 2 1

9 8 7 6

 
Figure 4: Rapidox RS232 pin configuration 

 
All other pins (1,4,5,7,6,9) = Don’t care 
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Reading Data:  Data is read using command “D”.  Send the single character “D” to 
the Rapidox.  The Rapidox replies with one of the following responses.  All valid 
responses end with [CR] & [LF] (where [CR] = ASCII 13  and [LF] = ASCII 10).  
 
Response: !Initialising[CR][LF] 
Meaning: Rapidox is still initialising 
 
Response: !Sensor heating[CR][LF] 
Meaning: Rapidox is still heating sensor to operating temperature 
 
Response: !Cleaning sensor[CR][LF] 
Meaning: Rapidox has finished heating sensor and is cleaning the sensor for 5 

seconds 
 
Response: !No sensor or sensor fault[CR][LF] 
Meaning: Sensor is not connected, or there is a fault in the sensor 
 
Response: d2.959E+05,-

1.426E+01,2.000E+00,,23:19:40,14/01/00,,,ALARM,PR[CR][LF] 
Meaning: “d” means data is being sent  
 “2.959E+05” is Oxygen reading in ppm 
  “,” = data separator 
 “-1.426E+01” is Oxygen sensor reading in mV 
 “,” = data separator 
 “0.000E+00” is pressure sensor reading in bar 
 “,” = data separator 
 “,” = data separator 
 “23:19:40” is Rapidox time – ignore this 
 “,” = data separator 
 “14/01/00” is Rapidox date – ignore this 
 “,” = data separator 
 “,” = data separator 
 “,” = data separator 
 “ALARM” means Oxygen alarm is active: O2 is too high or too low ** 
 “,” = data separator 
 “PR” – ignore this 
 [CR] = ASCII 13 (Carriage Return character) 
 [LF] = ASCII 10 (Line Feed character) 
 
** If oxygen alarm is not set, this data is empty, so the response would look like:  
  
d2.959E+05,-1.426E+01,2.000E+00,,23:19:40,14/01/00,,,,PR[CR][LF] 
 
Response: ? 
Meaning: “D” command was not recognised.  Try to send it again. 
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7.14.2 RS485 protocol 
 
Please contact Cambridge Sensotec for further information on this new feature. 

8. Rapidox Software Instructions 
 

8.1 Software Installation 
 
It is possible to program a range of variables to the Rapidox using an RS232 (or 
RS485 if configured) link with a PC running MS-Windows (all versions) and the 
supplied Rapidox software.  The software is installed automatically by inserting 
the Rapidox CD into the CD-ROM drive.  If auto-installation does not start then 
you can click the Windows START button and select RUN.  Type X:\setup.exe 
where X is the drive letter of your CD.  Alternatively access the CD from Windows 
Explorer or the ‘My Computer’ icon on your desktop, and double-click on the 
‘Setup.exe’ programme.  Follow the on-screen instructions to install the 
programme onto the hard drive.  Once installed you can access the programme by 
clicking START - PROGRAMS – Rapidox Software5. 
 
Please note that this software is generic and will work on several different 
machine versions.  Therefore not all the functions will be enabled for your 
Rapidox 1100Z. 
 

8.2 Getting Started 
 
Make sure that the Rapidox is connected to a free serial port on the rear of your 
computer.  These will nearly always be COM1 or COM2 but the software will scan 
through the ports until it finds the Rapidox.  The analyser must be switched on for 
this to succeed and while you are communicating with it.  On start up the 
software will locate the Rapidox and display the following page6: 

 

                                                 
5 The software has been tested successfully on most language machines including Chinese & 
Japanese 
 
6 The values displayed in the columns of boxes above the ‘Read’ and ‘Write’ buttons may differ 
from those shown.  NOT ALL features are available with this model. 
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Figure 5: Rapidox configuration page 

 
The yellow status box at the bottom will display confirmation that the Rapidox 
was found and the result of the last action, or any error messages if there is a 
problem with communication.  If you experience problems check that your serial 
cable7 (supplied) is correctly fitted to a valid serial port.  Also check the status of 
your COM port settings in Device Manager accessed by clicking START – Settings 
- Control Panel.  

8.3 On-Screen Help 
 
You can access the on-screen help facility at any time by clicking on the help 
menu on the menu bar and select the ‘Help’ option or press F1. 
 

8.4 Configuration Page 
 
The configuration page is split into two and you can toggle by clicking on the 
folder tabs labelled “config 1” and “config 2” page allows the user to reprogram an 
array of variables used by the Rapidox.  Once written to the Rapidox, the new 
variables remain permanent until overwritten. 
 

                                                 
7 There are several types of serial cable available.  You must use a cable as supplied where there 
are straight through connections, i.e., pin 2 to pin 2, pin 3 to pin 3 and pin 5 to pin 5.  Other cable 
formats will not work. 
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To read the current configuration stored in your Rapidox select ‘Read Analyser 
Configuration’ from the file menu.  Note that the edit boxes on the RHS will turn 
red if the value is different to that just read and a red asterisk will appear next to 
the ‘Write’ button to warn you that a change has been made.  The left-hand set of 
grey text fields (‘read fields’) will be updated with the current configuration data.  
To save this information (e.g., if several people share the same instrument) press 
the long copy button to transfer the data into the edit boxes, select ‘Save 
Configuration as’ from the file menu and choose a filename.  This data set can be 
subsequently be reloaded at any time by selecting ‘Load Configuration File’ button 
and selecting the directory where the configuration files have been stored. 
 
If at any time you wish to restore the machine to its factory default settings select 
‘Default Configuration’ from the file menu to load these values.  The software will 
search for a unique rxc file that is loaded onto the PC during the software 
installation.  The filename is 2100***.rxc where *** is the last three digits of the 
serial number located on the rear of the machine.  This file is also located on the 
CD-Rom that came with the machine.  Normally this file is located in the main 
Rapidox directory but if the software can not locate it then it will ask you for the 
serial number to help it search.  With the correct rxc file loaded simply press 
COPY to transfer the defaults into the edit boxes and then select WRITE to load 
them back into the Rapidox. 
 
The right-hand set of white editable text fields (‘write fields’) is used to enter new 
values to be programmed into the Rapidox.  The values in these fields can either 
be entered manually, or copied across from the ‘read fields’ by clicking the vertical 
‘Copy’ button, and then edited as required8.  Alternatively, you can load saved 
configuration data by selecting ‘Load Configuration’ from the file menu and 
selecting the required file.  In order to programme the analyser select ‘Write 
configuration to the analyser’ from the file menu. 
 

8.5 Reconfiguring the Analyser 
 
The on-screen edit boxes contain variables that can be reprogrammed into the 
Rapidox in exactly the same manner as using the front Keypad.  For a full 
description please refer to the relevant section in this manual. 
 
The user can choose whether to use ppm or percent notation to edit the text boxes 
by selecting the UNITS menu and clicking on percent or ppm.  To access a field, 
either click inside it or use the TAB key to scroll through them. The field 
parameters are as follows: 

                                                 
8 Note that when you click on the copy button both pages are updated at the same time and there is 
no need to repeat the action when you toggle to the other page. 
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8.5.1 Config 1 Screen 
 
1) Oxygen Range:  Not available for the Rapidox 1100Z 

 
2) Oxygen Units & Format: See Section 7.8 for a full description.  Use the 

drop down box to select PPM EXPONENTIAL, PPM MIXED, AUTO%/PPM 
or PRESSURE.  The default setting is AUTO%/PPM. 
 

3) Temperature Units/Enable: Not available for the Rapidox 1100Z 
 
4) Pressure Units: See sections 7.8 and 7.10 for a full description.  Use the 

drop down menu to select MBAR, TORR or KPa as the unit for pressure 
measurement.  The default setting is MBAR. 
 

5) Pressure Correction Mode: See section 7.11 for a full description.  Use the 
drop down menu to select NONE, AUTOMATIC or MANUAL.  The default 
setting is NONE. 
 

6) Operating Mode:  Not available for the Rapidox 1100Z 
 
7) Auxiliary Output Parameter: Not available for the Rapidox 1100Z 
 
8) Alarm Outputs: See section 7.7 for a full description.  Use the drop down 

menu to select OFF or ON.  When set to ON the alarm circuits on the rear 
are activated.  The default setting is ON. 
 

9) Audible Alarm: See section 7.6 for a full description.  Use the drop down 
menu to select OFF or ON.  When set to ON the buzzer will sound when an 
alarm is activated.  The default setting is ON. 
 

10) Visible Alarm: See section 7.6 for a full description.  Use the drop down 
menu to select OFF or ON.  When set to ON the front display will show the 
word ALARM (flashing) when an alarm is activated.  The default setting is 
ON. 
 

11) LCD Refresh interval:  Use the drop down menu to select a refresh rate for 
the LCD (min 0.1, max 1.5 sec).  The default is 0.3 seconds. 
 

12) LCD Second Line Option:  See section 7.9 for a full description.  Use the 
drop down menu to select PRESSURE or NONE 
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8.5.2 Config 2 Screen 
 

 
Figure 6: Configuration 2 page 

 

13) Calibration Gas 1:  Use this box to enter a new value for the first cal gas.  
The value can be entered either in % or ppm depending on the units 
selected.  The default is %.  Enter a value such as 10.1 for 10.1%9.  The 
default value for cal gas 1 is 20.95% 
 

14) Calibration Gas 2:  Use this box to enter a new value for the second cal 
gas.  The value can be entered either in % or ppm depending on the units 
selected.  The default is %.  Enter a value such as 0.1 for 0.1%.  The default 
value for cal gas 2 is 0.001% (10ppm). 
 

15) Calibration Constant A & B:  These boxes contain the calibration constants 
that the Rapidox calculates automatically when you perform a calibration.  
You will see that they change each time you perform a new calibration.  It 
is possible to manually edit these but this should only be attempted after 

                                                 
9 Note that software is ‘regionally aware’ and will therefore accept and display data using the 
decimal separator that is set in the PC’s Regional Settings in the Control Panel.  For example, in the 
UK or US, you might enter the value 2.5 - in continental Europe this would normally be entered as 
2,5 assuming the PC’s Regional Settings have been set up to use ‘,’ as the decimal separator.  The 
software also works with non-English versions of Windows including Chinese. 
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consulting with Cambridge Sensotec.  Normally they are just provided for 
information and should be left untouched.  The default settings are A= -
46.482 and B= -38.845.  Note that the values are always negative as this 
follows the convention of the Nernst equation. 
 

16) High & Low Alarm Thresholds:  Use these two boxes to enter new values 
for the alarm trigger points.  The alarm High value must always be greater 
than the alarm low value.  The value can be entered either in % or ppm 
depending on the units selected.  The default is %.  Enter a value such as 
10.1 for 10.1%.  The default values are 25% for Alarm High and 0.001% for 
Alarm Low. 
 

17) O2 Analogue Output (0V/4mA & 10V/20mA):  Use these two boxes to set 
the High and Low oxygen values for the analogue outputs (6) on the rear 
panel.  For example if you want 4mA to represent 1% and 20mA to 
represent 21% then enter these two values into the appropriate boxes.  The 
value can be entered either in % or ppm depending on the units selected.  
The default is %.  The default values are 25% for the high setting and 
0.001% for the low setting. 
 

18) Operating Pressure: Not available for the Rapidox 1100Z 
 
19) Gas 1 & Gas 2 emf (mV):  These values are for information purposes only 

and cannot be adjusted.  They represent the voltage that the Rapidox 
measured on the sensor at the point of calibration.  These values are used in 
the calculation of the A & B values derived from the Nernst equation.  As a 
guide the emf in air is around -8mV and the value at 10ppm is around 
+190mV.  Exact values depend entirely on the individual sensor. 
 

20) Oxygen and helium impedance setting: Not available for the Rapidox 
1100Z 

 
Once you have finished editing the parameters, select ‘Write Configuration to 
Analyser’ from the file menu and the new data set will be written to the Rapidox.  
The Rapidox is reprogrammed using the new configuration.  The software then 
reads the new settings back from the Rapidox and displays them in the boxes on 
the left-hand side confirming that the configuration was successful.  When you 
have finished programming the analyser for new calibration gases you must 
recalibrate the instrument to benefit from the changes. 

8.6 On-Screen LCD 
 
It is possible to display an LCD emulator on the desktop of your PC.  This 
reproduces exactly the display on the Rapidox unit and is convenient if you are 
some distance away from the machine.  To activate the LCD select the utilities 
menu and select the LCD on option.  This will display a small window showing 
the LCD that can be positioned independently anywhere on the desktop. 
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Figure 7: On-screen LCD 

 
The blue LED indicator will flash to show that the display is updating. 
 

8.7 Remote Calibrating and Cleaning 
 
With the on-screen LCD display active it is possible to remotely calibrate the 
analyser and clean the sensor.  Click on the down arrow icon in the bottom right-
hand corner of the LCD display to expand the window: 
 

 
Figure 8: Remote calibration and clean function 

 
Use the three buttons to calibrate or clean the sensor directly from the PC.  Note 
that you will receive a prompt asking you if you wish to proceed before the 
calibration actually takes place. 
 

8.8 Setting Analyser Date and Time 
 
The current date and time of your PC are displayed on the configuration screen 
and can be loaded into the Rapidox by selecting the Utilities menu and clicking 
the ‘Set date and time’ option.  This information is used in the RS232 data string 
for data logging purposes.  Make sure that your PC clock is set correctly before 
using this function, as you cannot edit the date and time shown by the Rapidox 
software.  The date and time formats displayed are those set in the PC’s Regional 
Settings. 

9. Rapidox Data-Logging Software 
 

9.1 Introduction 
 
The Rapidox software includes a full data logging facility.  Data can be saved to a 
file automatically at regular intervals and the format is compatible with modern 
spreadsheet programmes such as MS-Excel.  A live-time graphing facility is also 
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included which has many powerful features.  Note that the data logging facility 
will only function if the analyser is in NORMAL run mode. 
 

9.2 Setting up the Data Logger 
 
Click on the tab labelled ‘Data Acquisition’ to display the following page: 
 

 
Figure 9: Data Logging page 

 
During logging, data from the analyser is shown in the central area of this page.  
The data is displayed in the following columns: time (in seconds), the raw signal 
from the sensor (in mV), the oxygen value (in ppm scientific notation), pressure in 
mbar, the time (in regional format), the date (in regional format), and status 
(displays the range setting or the word ALARM if the alarm is activated). 
 
To start data logging select the frequency of measurement by entering a time and 
selecting a unit from the drop down list.  For example if you wish to log data once 
every minute type 1 in the box and select ‘Mins’ from the drop down menu. 
 
You can open the NOTES window at any time by selecting NOTES from the ‘Data 
Logger’ drop down menu.  A small text box appears in which you can type a text 
message.  This note is then saved as a header in the data file set and can be viewed 
along with the data. 
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You can either choose to have data logged continuously until ‘Stop’ is selected 
from the Data Logger menu, or you can choose to set a time limit for data logging 
by checking the box labelled ‘Time Limit’, setting the duration in the ‘Run For’ box 
and selecting units with the drop down list.  For example if you wish to log data 
for thirty minutes type ‘30’ in the box and select ‘Mins’ from the drop down list. 
 

9.3 Running the Data Logger 
 
If you wish to save the data into a file for later use, check the ‘Save to File’ box 
before selecting ‘Run’ from the Data Logger menu.  You will be prompted for a file 
name and location before data logging commences.  The file and path information 
will appear in the box at the top of the page labelled ‘Data File Name’.  If you 
forget to select file saving before starting a run, you will nevertheless be prompted 
at the end as to whether you wish to save the run data. 
 
The blue progress bar displays the state of completion of the run, and the blue box 
to the right of it the same information as a percentage.  You can stop the run at 
any time by selecting ‘Stop’ from the Data Logger menu.  The yellow Status bar at 
the bottom of the page gives information about the data logging operation. 
 
Once data logging is complete you may open the text format data file using any 
compatible spreadsheet programme such as MS Excel, and use the data to 
generate plots and reports. 
 
You can pause the data logger at any time by selecting ‘data logger’ and ‘pause’.  
Repeat to continue logging from where you left off, noting that the clock keeps 
ticking during the pause period. 
 

9.4 Auto Date Stamped Files 
 
If you are planning to run the data logger for extended periods of time then you 
should consider checking the ‘Auto date stamped file’ option.  This feature will 
save the data at midnight for the previous twenty four hours and so on until the 
data-logging is complete OR the user interrupts.  The data file is stored with a date 
suffix in brackets in yy-mm-dd format. 
 
This feature ensures that data is saved periodically in sensible sized files.  This 
will prevent the computer from crashing and will also ensure that the data is small 
enough to fit into an Excel spreadsheet 
 
As an example, the user wishes to run the data-logger for seven days recording 
every minute starting at lunchtime on 12th November 2005.  He starts the data 
logger with the auto-date stamp function enabled.  When prompted he gives the 
filename as test1.  In this situation the data logger will run from lunchtime to 
midnight and then save the first file as test1 (2005-11-12).  The data logger then 
clears and continues for another twenty four hours until midnight the following 
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day.  The data is then stored as test1 (2005-11-13).  This will continue for seven 
days when the data-logger will finish. 
 
After this the user will have a sequence of files: 
 
test1 (2005-11-12).txt 
test1 (2005-11-13).txt 
test1 (2005-11-14).txt 
 
And so on.  Combined together they represent all the data over the last seven days.  
Note that the Rapidox uses the computer clock and date to perform this action, so 
make sure that they are correct before starting a run. 
 
To view the data in its entirety the user would need to load each file in turn back 
into Excel to combine. 
 

9.5 Live Time Graphing Screen 
 
The Rapidox data-logging package includes a live-time graphing facility that 
allows you to monitor the progress of your data in a graphical format (see Figure 
10).  To access the graph check the box labelled ‘Show Graph’.  The graph will 
appear in a new window, and can be accessed at any time without disturbing a 
run that is already in progress.  You can select  ‘Run’ and ‘Stop’ from the Data 
Logger menu to begin and end data logging, and the window can be minimised to 
(and restored from) the task bar while logging data.   
 
To close the window and return to the main data-logging page select ‘Close Plot’ 
from the File menu or click on the close window button. 
 
The features of the graph window are described below: 
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Figure 10:  Live-time graphing screen 

 

9.6 Main Graph Window 
 
The graph is an XY plot, with time plotted on the X-axis, oxygen plotted on the 
primary Y-axis (Y1) and pressure plotted on the secondary Y-axis (Y2).  The X-axis 
and the two Y-axes auto-scale during data logging so that all data points are shown 
on the graph. 
 

9.7 Plot Colours 
 
The default colours used on the graph are set to blue for oxygen and red for 
temperature.  To change the colours double-click on the coloured axis label at the 
top of each axis.  A colour palette window will appear (see Figure 11) and a new 
colour can either be chosen from a colour box, or for more variety, by clicking the 
‘Define Custom Colors >>’ button.  Click on ‘OK’ to select the new colour or 
‘Cancel’ to return to the graph without change. 
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Figure 11: Plot colour palette menu accessed by double-clicking on the axes titles. 

 

9.8 Graph Titles and Labels 
 
If you want to change the text of the graph axis labels, place the mouse pointer 
over the text and do a single left click to enter edit mode.  The text can then be 
modified.  Similarly, to change the title of the graph, place the mouse pointer over 
the title and click once to edit.  If you choose not to enter a title the graph will 
display the path and filename of the run as the new title once the run has 
finished.  Note that these changes are only temporary and will be overwritten by 
the defaults if a new run is started or the graph window is closed and reopened.  
They are provided so that the plot may be printed with alternative labels. 
 

9.9 Plot Co-ordinates 
 
The box labelled ‘Plot co-ordinates’ to the upper left of the graph window displays 
the actual plot co-ordinate value at the mouse pointer.  This can be used to get a 
quick oxygen value from the graph.  Simply place the mouse pointer at a place of 
interest and read the corresponding X1 and Y1 values in the box. 
 

9.10 Last data point 
 
During data acquisition, the box labelled ‘Last data point’ will appear at the upper 
middle of the graph window.  It displays the last data values read from the 
analyser. 
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9.11 Using the Cursor 
 
Clicking and holding the left mouse button with the pointer over the ‘C’ at the top 
of the plot area activates the cursor, which appears as a vertical dashed line on the 
plot.  While keeping the mouse button pressed, you can now move the pointer 
anywhere in the plot area or on the ‘C’ in order to move the cursor.  The box 
labelled ‘Cursor’ to the upper right of the graph window will display actual values 
for oxygen, temperature, time and the data point number (n) at or immediately to 
the left of the cursor position.  The cursor can be used to investigate actual data 
values at specific points of interest on the graph. 
 

9.12 Zooming 
 
You can zoom in to any part of the oxygen plot by simply placing the mouse 
pointer on the new graph start position and then clicking and dragging a new box 
to re-size the graph.  The label on the box to the upper left of the graph window 
will change to ‘Zoom box co-ordinates’, and an extra set of co-ordinates, labelled 
X2 and Y2, will appear, showing the co-ordinates in X and Y units of the second 
corner of the zoom rectangle as you drag the mouse pointer.  The plot will zoom 
and auto-scale when you release the mouse button.  This can be repeated if you 
wish to zoom in even further.  To zoom back to the original size select ‘Zoom Full’ 
from the View menu. 
 
Note that although you can use the zoom facility during a live run, the graph will 
auto-scale to full size with each new data point. 
 

9.13 Y-Axis Graph Units 
 
You can toggle the Y1 oxygen units at any time from percent to ppm and vice 
versa.  Select ‘O2 Units’ from the View menu and chose either percent or ppm.  
The current selection is then displayed in the top right box labelled ‘O2 Axis’. 
 

9.14 Oxygen Scale 
 
You can display the Y1 oxygen axis in linear or logarithmic format at any time by 
selecting ‘O2 Scale’ from the view menu. The current selection is then displayed 
in the top right box labelled ‘O2 Axis’.  Note that the zoom function is disabled 
when you are viewing on a log scale. 

9.15 Second Y Axis 
 
The secondary Y axis located on the right hand side of the graph can be used to 
display either temperature taken from the type K thermocouple, pressure taken 
from the pressure sensor or dew-point taken from the dew-point sensor fitted to 
the Auxiliary socket on the front.  It is not possible to display temperature and 
pressure / dew-point at the same time.  The axis is linear and auto-scaling.  To 
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select the mode of the secondary axis select ‘view’ and then ‘second axis display’.  
Choose from ‘none’ or ‘pressure’. 

9.16 Loading an Old Run 
 
A previously logged data file can be loaded and viewed by selecting ‘Open Data 
File’ from the File menu and selecting the appropriate TXT or CSV file.  A 
progress bar is displayed while the data is being imported.  Note that very large 
data files may take several seconds to load.  The data is re-graphed and you can 
zoom, label axes, change colours etc., before printing the graph. 
 

9.17 Printing Graphs 
 
You can print the graph at any time by selecting ‘Print Plot’ from the File menu.  
This will bring up the printer dialogue box for your specific printer where you can 
chose various printing options.  Make sure that the printer page is set to landscape 
to obtain a full size print out. 
 

9.18 Data Logging in the Background 
 
It is possible to begin data logging and then minimise the windows to continue 
working with another application.  To minimise the graph simply click on the 
minimise button on the blue title bar at the top of the window.  You can then use 
the ALT + TAB keys to take you to other programmes already running.  To return 
to the graph simply maximise from the start menu bar or press ALT + TAB again.  
If the graph does not redraw immediately select ‘Zoom Full’ from the View menu 
to redraw. 
 

9.19 Pausing the Data Logging 
 
You can pause the data-logging at any time during the run by selecting the ‘data 
logger’ menu and selecting ‘pause’.  Repeat the action to continue, noting that the 
live graph will draw a straight line between the paused points to keep continuity 
of the axes.  The clock keeps ticking during the pause period. 
 
If you decide to access the menu of the Rapidox using the front keypad during 
data logging, then the software will pause automatically.  A message appears on 
the screen informing the user that the unit is being accessed from the keypad.  
Once the menu has been exited, the software will continue data logging from 
where it left off. 
 

9.20 Changing the Data Logging Parameters Mid-run 
 
Once the data logging has begun you may change the sample interval time by 
pausing the data logger and then entering a new value for the time interval.  The 
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data logger can then be resumed with the new values in place.  Note that you can 
not change units (e.g. seconds to hours) once logging has started.  If you originally 
selected seconds then you may change the current value to a new value between 1 
and 3600 seconds, if you originally selected minutes then you may change 
between 0.02 and 360 and if you selected hours you may change between 0.01 and 
6 hours.  Note it is not possible to modify he original total length of time that the 
data logging will run for once a run has commenced. 
 

9.21 Working with Spreadsheets 
 
The data-logger saves data files in a standard comma separated ASCII text format 
which can be readily imported into spreadsheet programmes such as MS Excel, in 
order to produce plots and reports as desired.  For specific information on how to 
import text files into your spreadsheet programme please refer to the help guide 
supplied with the programme. 
 
Data is saved in comma separated value format, with a ‘.txt’ file extension as the 
initial programme default.  However, when entering the file name, you can instead 
select a ‘.csv’ extension: the programme will register the last used file extension as 
the new default.  The ‘.csv’ extension is recognised by MS Excel, so that opening 
the file will automatically run MS Excel, and this may be of benefit if your 
regional decimal separator is period ‘.’ rather than comma ‘,’.  However, if your 
decimal separator is comma, you should continue to use the ‘.txt’ extension and 
open the file explicitly from within your spreadsheet programme, defining the 
field delimiter as ‘comma’ where appropriate. 
 

9.22 Disaster Recovery 
 
To prevent catastrophic loss of important data during a computer crash or power 
failure, the data is automatically saved point by point in a temporary file called 
‘Rapidox temporary data file.txt’.  This file is located in the same directory as the 
main Rapidox programme itself and can be renamed or copied to recover data that 
would otherwise be lost.  Note that this file is overwritten each time ‘Run’ is 
selected from the Data Logger menu so make sure all data is recovered 
successfully before starting another run. 
 
Note that during a run using the ‘auto date stamped’ feature the temporary data 
file is wiped clean as soon as the previous data set has been saved successfully.  In 
the case of a crash the temporary data file should be used to recover the last day’s 
worth of data that was not saved to the hard disc. 
 

9.23 Diagnostics 
 
The Rapidox software includes a diagnostics page that is accessed from the tab 
labelled ‘Diagnostics’.  This screen will display various values and settings that are 
operating inside your machine.  There is no editing possible on this page – it is 
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purely for information and to enable technical support help you should you 
experience difficulties with your machine.  You may be asked to record values 
from this page if trouble shooting is required. 

10. Troubleshooting 
 
Q: The Rapidox says 'sensor heating' but won't begin measuring. 
A: Check to see if the sensor is getting hot.  If it is then make sure the cable 

plug is located firmly in the socket (2).  If you are still having problems 
contact Cambridge Sensotec for advice.  If the sensor stays cool then the 
internal heater has failed and the sensor needs replacing. 

 
Q: The Rapidox won't power up at all. 
A: There are fuses located on the power socket on both live and neutral lines.  

These are standard 20mm (1A for 240V versions, 2A for 110V) fuses 
available from a supplier such as RS Components. 

 
Q: The Rapidox gives strange readings that are way off the expected values. 
A: Check the software to make sure that the ‘Operating pressure’ is correct 

otherwise this will introduce a multiplying error.  Also check to make sure 
which two calibration gases are selected.  Are they the same as the actual 
gases you used to perform the calibration?  If not you can change their 
values using the software.  Also check to see that the pressure correction 
mode is set to NONE if there is NO pressure sensor attached. 

 
Q: The sensor does not read 20.9 - 21.0% in air (actual value is 20.95%). 
A: If the room air is very humid, it will slightly affect the observed 

measurement or the sensor may have drifted slightly because of natural 
ageing.  If you are using air as a calibration point then simply do a quick re-
calibration in the air to compensate for this. 

 
Q: I messed up the calibration procedure and the analyser is not working 

properly. 
A: Return the box to the factory defaults using the keypad or communications 

software, by selecting ‘Default Configuration’ followed by ‘Write 
Configuration to Analyser’ from the File menu.  Now try re-calibrating the 
Rapidox. 

 
Q: The software will not talk to the Rapidox. 
A: Make sure that you are using the correct cable, as supplied (pin 2 to pin 2 

etc).  A crossed RS232 cable (pin 2 to pin 3 etc.,) will not work.  Make sure 
that your COM ports are recognised by your computer.  Check in your 
Windows device manager to see if there are any conflicts.  If you have an 
internal modem fixed to your PC you may experience difficulties using this 
software.  Contact Cambridge Sensotec for further advice. 
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Q: I selected ‘Write to the Analyser’ and now the Rapidox is way off 
calibration. 

A: Only select ‘Write to the Analyser’ once all the values are correctly entered 
in the boxes on the right.  The best procedure is to ‘Read Analyser 
Configuration’ and then press ‘Copy’ so the values in the boxes are the same 
as those stored in the Rapidox memory.  You can then edit these values and 
then select ‘Write to the Analyser’ when finished. 

 
Q: How do I get back to the factory calibration for my instrument. 
A:  Select ‘Load Configuration File’ from the File menu and look for the rxc file on your 

CD.  Select this file and then select ‘Write to the Analyser’.  This will load the 
factory calibration back into the Rapidox.  Alternatively you can load a standard 
default configuration any time using the ‘Load Default’ option on the File menu.  
This configuration will not be perfect for your analyser but will be good enough to 
get you started again. 

 

10.1 Warranty 
 
The Rapidox analyser has been carefully tested and inspected before shipment 
and is guaranteed to be free from defective materials and workmanship for a 
period of twelve months from date of purchase.  The sensor head is replaceable 
and has a life expectancy in excess of 35,000 hours.  However, if the analysis gas 
contains corrosive gases or large quantities of particulates, sensor life may be 
shortened.  In the case of the latter, it is normally possible to insert a filter prior to 
the sensor head to remove the particulate material. 
 

10.2 Conditions of Warranty: 
 
1) This warranty is in addition to and does not affect any statutory rights of 
consumer purchasers.  This warranty is valid worldwide on a back to base basis. 
 
2) This warranty covers breakdowns due to design or manufacturing faults; it does 
not apply to damage, however caused, wear and tear, neglect, unauthorised 
adjustment or repair, or any items of limited natural life. 
 
3) In the event of failure, please take the following action: 
 
a] Refer to the “Troubleshooting” section of your instruction manual to identify 
and possibly correct the problem. 
 
b] If the fault cannot be resolved, please contact the Cambridge Sensotec service 
and repair centre at the address given on the cover of the manual. 
 
4) The warranty period applicable shall be 12 months from the date of purchase. 
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Rapidox CERTIFICATE of CALIBRATION 

 
 
 
Date:  ………………………. 
 

 
Rapidox Serial number:   ………………………………………. 

 

Calibration  Constant A   ………………………………………. 

 

Calibration Constant B   ………………………………………. 

 

Calibration Constant C   ………………………………………. 

 

Calibration Gas 1    ………………………………………. 

 

Calibration Gas 2    ………………………………………. 

 

Calibration Gas 3    ………………………………………. 

  

Configuration Filename   ………………………………………. 

 

 
 
Calibrated by:    ………………………………………. 
 
 

Signed:     ……………………………………….

 
Cambridge Sensotec Ltd. 
Unit 8 Royce Court 
Burrel Road 

 

Tel. +44 1480 462142 
Fax. +44 1480 466032 

www.cambridge-sensotec.co.uk 
sales@cambridge-sensotec.co.uk  St Ives 

Cambs 
PE27 3NE 
ENGLAND 

VAT no. GB 745 939975 
Registered in England No. 4035592 

VAT No. 745 9399 75 
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